
October 2021 
Published by Tennessee Watercolor Society

GOLDEN VOLUNTEERS 

Helen Burton

Helen Burton is a gifted 
artist who has a passion 
for TnWS and traditional 
watercolor.

Fred Rawlinson

Fred Rawlinson loves 
teaching, mentoring and 
sharing his love of water-
color. 

Forest Bathing and Art 

by Elizabeth Sanford (R2) 
talks about the Associa-
tion of Nature and Forest 
Therapy where she has 
fulfilled a lifelong dream 
of becoming a Certified 
Guide. They encourage a 
deeper relationship with 
connections of nature and 
how her watercolor plays 
into this connection.

Healing Powers of Art 

by Barrie Skoda Foster 
(R1) shares insight from 
Barrie on her experience in 
Art Therapy. Barrie recently 
began a job with the VA as 
an Art Teacher. She quotes 
poet Nikki Giovanni in 
saying “Art offers sanctuary 
to everyone willing to open 
their hearts as well as their 
eyes.”

HEALING AND ART

FEATURED ARTICLES

THE HEALING POWER OF ART
Forest Bathing and Art
Healing Powers of Art
Healing Arts: Sharing Our Stories

ELEVATE, EDUCATE & ENCOURAGE
Sizing Your Photographs (PC)
How to Size Photographs (Mac)
Photographing your Art for the 

Internet
Painting Records
Why Journals?
Using PayPal

In this issue 
In this issue of ArtBeat, we are again offering two 
themes. The first theme is The Healing Power of 
Art. It is well known that the act of creating is a pow-
erful force which fulfills needs, releases endorphins 
which reduce stress and pain, and simply makes us 
feel good. We have articles by two of our members, 
Elizabeth Sanford and Barrie Skoda Foster. A third 
article was submitted by guest writer Mallory  
Montgomery who is a board-certified art therapist 
who specializes in medical art therapy. 

The second focus is a timely collection of past and 
new articles full of information that will help answer 
questions related to exhibiting or sharing your art. 
Past issues of ArtBeat and Medium contain a wealth 
of information and are available by visiting  
TnWS.org. To aid in finding these articles, a list with 
title, author and issue dates are included in this 
publication. Simply visit TnWS.org to read the full 
articles. New informative articles by members Linda 
Sue Campbell, Mark Cobbe, Peach McComb, Pat 
C. Patrick, and Tuva Stephens are also available.  

This issue also welcomes two new Golden Volun-
teers, Fred Rawlinson (R1) and Helen Burton (R3). If 
you would like to nominate anyone to be honored as 
a Golden Volunteer, let us know. 

http://TnWS.org
http://TnWS.org
mailto:pkseaystudio%40gmail.com?subject=
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This project is funded under an agreement with the Tennessee 
Arts Commission and the National Endowment for the Arts. The 
Tennessee Arts Commission is a state agency that funds and 
supports quality art experiences to ensure that the citizens of 
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Pennings from Pam 

by Pamela Kingsley Seay
 
Greetings from West Tennessee 

Fall is finally in the air on the west-
ern edge of Tennessee. So much is 
happening here and all through our 
state. We are still learning to cope 
with the Covid issues keeping us 
closer to our homes and 
dealing with life changing 
events. I am so impressed 
by the talent and heart 
of the TnWS members. 
Hearts that are giving and 
caring, as seen recently by 
the number of members in-
volved in an online auction. 
Artists across Tennessee 
donated works which were 
sold to raise money to aid 
so many who lost their 
lives, loved ones and prop-
erty. They set a goal and exceeded it! 
Thanks, and kudos to all who partici-
pated in that event.  

Speaking of setting goals and looking 
ahead, it is that time again. Barbara 
Jernigan (Chair of Nominations) and 
her team are working hard to gather 
up a new slate of officers and com-
mittee chairs to serve our Society in 
2022-2024. If you are asked, SAY YES! 
If you are not asked, then OFFER UP 
YOUR SERVICES! We need several 
major positions in leadership, yes, 
but there is a lot to do. Lots of smaller 
jobs.  

This organization was built by 
VOLUNTEERS (we ARE the Volunteer 
State!), and for 50 years our volun-
teers have served us well. Today our 
membership consists of an aging 
population. Many members have 
been serving for up to 20 years! It is 
time to “make new friends, but keep 
the old, one is silver and the other is 
gold.” In my day I was one of those 
who both worked away from home, 
but also raised a family, often alone 
as my husband traveled. My free time 
was limited but I managed. Today’s 
young people have less time than I 
did. Millennials do not give up their 
free time without a great deal of 

thought. So, finding a younger mem-
bership is indeed a challenge. But 
never fear, ART cannot be shoved 
away for long.  

Determining what to do to ensure 
viability over the next 50 years is a 
challenge. Yes, we could keep the 
status quo, or we could engage in 
conversations now, looking to the 
future. To that end, our current lead-

ership shared a 
survey with the 
entire member-
ship this year. 
We heard back 
from about 40% 
of the members 
(excellent num-
bers of return for 
a survey of this 
type.) Now we 
are looking at the 
results. Our Full 
Board of Di-

rectors will participate in a Zoom 
conference on November 6, 2021, to 
brainstorm thoughts and ideas. If you 
are interested in this subject, contact 
Ann Aiken or Vickie Montgomery 
to be added to the invitation list.  

Throughout our history, TnWS held 
several conversations planning the 
future of the society. These conversa-
tions are so important. As we meet, 
we must be open and willing to 
listen to all the ideas that can take us 
forward. It may be different that we 
currently do things, or it could be a 
tweak here or there. Or the consen-
sus could be continuation of certain 
ideas.  Our world has changed drasti-
cally in the last 20 years. We need to 
find a way to adapt to lifestyle chang-
es such as more digital presence than 
in person. (I love the ability to meet 
via Zoom rather than drive for hours 
to meet for an hour, BUT I do so miss 
in person contact!) I do believe TnWS 
can meet this challenge without 
losing our basic mission and goals. 
Remember no one person OWNS 
TnWS. We are all caretakers. We are 
members. We have much in com-
mon, but much individuality, too. Let 
us be good stewards and manage 
ourselves and look to another 50 
years! 

mailto:pkseaystudio%40gmail.com?subject=
mailto:archiann51%40gmail.com?subject=
mailto:gaylaseale%40comcast.net?subject=
mailto:johnandlil%40charter.net?subject=
mailto:jsduke2003%40yahoo.com?subject=
mailto:pat.c.patrick%40gmail.com?subject=
mailto:jbnashtenart%40comcast.net?subject=
mailto:linn.stilwell%40comcast.net?subject=
mailto:kathleenhaynes%40gmail.com?subject=
mailto:johnandlil%40charter.net?subject=
mailto:bbjernigan%40gmail.com?subject=
mailto:tuvart%40charter.net?subject=
mailto:pat.c.patrick%40gmail.com?subject=
mailto:emshaas%40gmail.com?subject=
mailto:jjporter%40tds.net?subject=
mailto:emshaas%40gmail.com?subject=
mailto:tuvart%40charter.net?subject=
mailto:mark.cobbe%40icloud.com?subject=
mailto:pkseaystudio%40gmail.com?subject=
mailto:alyssapeacock972%40gmail.com?subject=
mailto:mark.cobbe%40icloud.com?subject=
mailto:pkseaystudio%40gmail.com?subject=
mailto:tuvart%40charter.net?subject=
mailto:has4angels%40aol.com?subject=
mailto:patsyfriend3%40gmail.com?subject=
mailto:helenburtongraphics%40gmail.com?subject=
mailto:mark.cobbe%40icloud.com?subject=
mailto:emshaas%40gmail.com?subject=
mailto:jjporter%40tds.net?subject=
mailto:gaylaseale%40comcast.net?subject=
mailto:bbjernigan%40gmail.com?subject=
mailto:helenburtongraphics%40gmail.com?subject=
mailto:mark.cobbe%40icloud.com?subject=
mailto:emshaas%40gmail.com?subject=
mailto:pat.c.patrick%40gmail.com?subject=
mailto:archiann51%40gmail.com?subject=
https://stanmiller.net/
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Helen Burton

Introduction by Nick Long
Personal note from Wendy Latimer
Interview by Jan Alice Keeling

Have you ever met a person who was always willing to 
jump into the fray and help out with a problem, issue, or 
cause? Does she maintain her composure while taking 
fire from all sides and 
forge ahead towards an 
equitable solution? Is she 
always willing to share her 
knowledge, talent, and 
expertise? Are fairness and 
kindness adjectives that 
come to mind in describing 
her? Helen Burton is that 
person!

Beyond her sheer talent for 
creating beautiful water-
color paintings, Helen has 
a depth of knowledge of the medium that is unrivaled in 
our organization. If you want to know which paint manu-
facturer might have a more luminous yellow, talk to Hel-
en. If you want a well thought-out opinion—regardless of 
the topic—and need straightforward answers, ask Helen. 
She approaches every project with meticulous precision 
whether it’s newsletter design and proofing or organizing 
a paint-out for her multi-talented region. 

This is just the short list of Helen’s many attributes. Woven 
throughout all of this, you will discover Helen is always 
kind. Kindness is hard to achieve day-to-day in an organi-
zation with multiple personalities and multiple agendas. 
Helen Burton accomplishes this with grace and ease and 
is one of the treasures of the Tennessee Watercolor Soci-
ety. — Nick Long

If you have been a TnWS member since the early 2000s, 
Helen Burton is sure to be a familiar name and face. 
Living in the Chattanooga Region, Helen has been greatly 
relied upon by her Region, as well as by the statewide 
TnWS Board of Directors.

It would be almost impossible to list our many adven-
tures and accomplishments over the past twenty years. 
Helen has been a co: worker, a fountain of information, a 
tremendous help to all, and most of all, a dear friend. In 
honor of Helen, we reach out to our fellow TnWS mem-
bers, and all watermedia artists, to be a part of this great 
organization, to learn, to find life: long friendships, and to 

Fred Rawlinson

Introduction by Mary Spellings
Interview by Jan Alice Keeling

Fred Rawlinson. Wow! Now that is a guy who knows 
art! Fred Rawlinson was a dean at the Memphis College 
of Art for years. He is a gifted teacher and artist. He and 
his sweetie (wife) Jo have a gallery and teaching space 

in the Atelier Shopping 
center in Germantown 
where they have equipped 
many artists to excel in 
their individual work. Fred 
loves watercolor and has 
a very expressive style. He 
loves to paint nature, often 
spending countless hours 
on beautifully expressed 
trees. He has a way of 
capturing the simplicity of 
nature through his tech-
nique called pressing. He 

uses washes, lifting, scraping, calligraphy, tool marks, and 
texture to create master watercolors. He has a unique and 
recognizable style that is loved by many. He is loved by 
many. Fred Rawlinson is a blessing as an artist and men-
tor. —Mary P. Spellings

Jan Alice: How did you get into volunteering for TnWS? 
What was your first volunteer position?

Fred: I never had a “position.” Never wanted to serve as 
an officer. My first service, as I remember, was as a Gofer, 
meaning “to go for.” My faculty position at Memphis Col-
lege of Art offered me some flexibility in taking time off, 
and I had time available to help others who did not have 
time available. My wife and I loved to travel by car, and we 
found ourselves transporting paintings to be exhibited at 
annual shows. We were also available to pick up paintings 
and return them to the artists when annual exhibitions 
were taken down.

When you were thinking of volunteering for something, 
did you consider your own skills and what you enjoy 
doing?

As TnWS sought out out new members across the state, 
I was sometimes requested to be the “entertainment” 
at new-member gatherings. I would entertain by doing 
a painting while members watched. Perhaps because I 
love to teach, I enjoyed doing demonstration paintings at 
meetings… even if they were only “entertainment.”

Helen Burton continued on page 4 Fred Rawlinson continued on page 5

GOLDEN VOLUNTEERS 
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What have you learned from volunteer work for TnWS? 

Many activities are “behind the scenes” work that others 
are not aware of, so don’t expect to always be recognized 
for everything you do!

How do you manage time in order to volunteer? 

I sacrifice a lot of my personal time to get on the comput-
er and communicate with others about certain projects, 
and to produce the printed pieces required.

If you want to recruit another person for volunteer 
work, how do you go about it? 

I stress that such work is for the benefit of all of us and for 
the volunteer’s personal satisfaction in achieving some-
thing worthwhile they can be proud of. Right now I am 
asking all our members to be volunteers in bringing in 
award sponsors for the 2022 Exhibition. 

What was your biggest challenge in accomplishing your 
volunteer work? 

The 32nd Exhibition in 2010 was a tremendous undertak-
ing and involved recruiting many volunteers to make it a 
success.

What has been your most recent TnWS volunteer work?

Returning to two former volunteer positions, I have 
served as co-editor and page designer with Wendy La-
timer on the ArtBeat and Medium until 2021, and am on 
the Region III Team with Mark Cobbe and Marie Spaeder 
Haas. Now I am reprising my role as Chair of the Exhibi-
tion as it returns to Chattanooga as the 38th in 2022.

Is there anything else you’d like to say about volunteer-
ing for TnWS? 

Yes! Your investment in any commitment returns to you 
as 100% satisfaction in a job well done for the benefit of 
others. During these past twenty years I have truly be-
come a part of the Tennessee Watercolor family, forming 
warm and wonderful friendships. I am honored to know 
so many talented individuals who are such an inspiration 
to me.

make a difference in the Visual Arts Community as a vol-
unteer. Helen, I couldn’t have done the last two decades 
without you. — XOXO Wendy

Jan Alice: How did you get into volunteering for TnWS? 
What was your first volunteer position?

Helen: When I joined TnWS in 2002 I got involved in the 
preparation for the 2002 Exhibition at AVA in Chattanoo-
ga by helping to write and design the prospectus. 

When you are thinking of volunteering for something, 
do you consider your own skills and what you enjoy 
doing? How have you used your skills and joys in your 
volunteer work?

Yes. I have always been a writer and have training in 
graphic design. In 2003 I took on the newsletter for two 
years and named it ArtBeat, with the heading design an 
outline of the state of Tennessee and each of the major 
cities a star, plus the slogan “the pulse of our ‘state of the 
arts’”. In 2004 I became Region III Contact for five years. 
During that time I organized regional exhibits, designing 
and printing programs and writing press releases, plus 
other activities, communicating with printed flyers on 
color paper. That led to my becoming chairman of the 
32nd Exhibition in 2010 at Chattanooga State Communi-
ty College. I designed the catalog to emulate AWS with a 
horizontal format and named the top awards First Place 
Gold, Second Place Silver, Third Place Bronze with a TnWS 
medallion symbol. Total awards were $16,795, the high-
est amount at that time. For that show I designed Award 
Certificates that I have continued to produce for every 
exhibition since.

What is the TnWS volunteer work you have enjoyed the 
most? 

I enjoyed being the Regional Contact for Region III for five 
years. It gave me an opportunity to know the artists in 
the Chattanooga area by creating activities we could all 
participate in, especially local exhibitions.

Helen Burton continued from page 3
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What is the TnWS volunteer work you have enjoyed the 
most?

I’ve enjoyed demonstrating watercolor techniques at 
state-wide meetings as well as conducting workshops.

What have you learned from your volunteer work in 
TnWS?

Meeting new artist friends 
from across the state 
offered learning experi-
ences akin to “graduate 
study.” Had it not been for 
my serving in the ways 
mentioned here, I would 
not have had the pleasure 
of knowing, and learning 
from so many talented artists. Many remain friends to this 
day.

How do you manage your time in order to volunteer?

People find time to do the things they want to do. There 
were times when we had to reshuffle outside commit-
ments in order to serve TnWS, but there is always time 
available to do the things that are important to you. In 
my Bible study time I learned that all of us, God’s chil-
dren, have been given three T’s—Talent, Treasure, and 
Time—and we are expected by God to share with others 
a portion of each T.

If you want to ask another person to do volunteer work, 
how do you go about it?

Know the person you are recruiting and compliment 
them on their strengths. Tell them how they are needed. 
Then ask.

What was your biggest challenge in accomplishing your 
volunteer work?

Maintaining a high level of energy. When serving as “en-
tertainment,” one must be “on stage” at all times.

Do you have any more you’d like to say about volunteer-
ing for TnWS? 

As a volunteer, you are sure to meet a lot of great people 
from all across our great state

Fred Rawlinson continued from page 3

2022 Bi-Annual Exhibition Prospectus

Please visit the TnWS website to see the full 2022 
Prospectus

GOLDEN VOLUNTEERS 

https://tnws.org/wp-content/uploads/2021/07/2022-TnWS-Prospectus.pdf
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He has instructed workshops and 
juried art events around the world. 
A Signature Member of AWS, he 
was Juror of Awards for the 2018 
International Exhibition. He has 
been a full-time artist and univer-
sity-level instructor for more than 

 40 years, with a background 
in commercial illustration and 
graphic design.  

 Miller’s work has been fea-
tured in many publications 
like American Artist, Water-
color Artist, on the cover of 
International Artist in 2017, 
First Place Award for Figure/
Portraiture in The Artists 
Magazine International Com-
petition, Best of Show several 
times, Grand Prize in Water-
color Magic, and winning First  

STAN MILLER 2022 Juror, Award                   
Judge and Workshop Presenter 

Place in a number of their competitions, 
during the past 15 years. For a more 
extensive biography and to see more of 
his paintings, visit his website. 

Miller’s online demos exhibit his skillful 
yet relaxed watercolor instruction. 

An internation-
ally well known 
American artist 
from Spokane, 
Washington, 
Miller has won 
many awards. 

2022 W0RKSHOP REGISTRATION BEGINS NOVEMBER 1, 2021 

WORKSHOP DATES - MAY 17-20, 2022                                                                                                                                                       
Tuesday thru Friday, 9am-4pm                                   

FEE: $400 member / DEPOSIT $200                                              
$450 non-member / DEPOSIT $225                                                          

BALANCE due May 1, 2022                                                                
JANUARY 1, 2022 - Open to NON-MEMBERS 

 STUDENT LIMIT: 15 - 25  /  LOCATION: Townsend Atelier              
The Arts Building, 301 E. 11th St., Chattanooga                                                                                                              

REGISTER ONLINE: www.tnws.org / PAY thru PAYPAL  








Stan Miller is a popular workshop 
presenter. He will be teaching tech-
niques for Portrait  and Landscape 
each day.  

A selection of handout photographs 
of each subject will be available to 
choose for each day’s lesson as 
Stan guides the students through 
that painting. Following a painting 
demonstration, workshop partici-
pants will work on their own painting 
in order to fully understand the proc-
ess. Technique, color, composition, 
and design will be addressed 

Workshop artists will learn:   

 Portrait - The importance of lighting 
on the subject, facial expression, 
skin tones, personality and mood 
revealed with the application of color 
and contrast. 

Miller’s Nick’s Gaze shows his attention 
to detail, yet emphasizes the character 
of his subject with light and shadow. 





 

Landscape - Perspective in buildings, relationships between 
foreground and background with emphasis on atmosphere, 
special techniques for representing various surfaces, and 
color density.  At left - Miller’s Venice Calm 
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Paying through PayPal

by Lil Clinard, Treasurer TnWS

You do not need a PayPal account to pay via PayPal. It 
works just like the membership payment on our TnWS 
website. When you click the option to pay via PayPal the 
first screen comes up in PayPal with the option to pay 
with Debit or Credit Card. 

The next screen shows how to pay as a Guest. This screen 
provides all the information you need to register for a 
workshop. 

Left: First screen
Above: Second screen
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Forest Bathing and Art

by Elizabeth Sanford

Is your art inspired by the natural world? Do you feel a 
sense of relaxation or restoration after spending time in 
nature? Are you interested in exploring ways to deepen 
those kinds of experiences while supporting well-being? 
If the answer to any of these questions is yes, then you 
might enjoy going on a Forest Bathing walk.

Although the pandemic certainly rearranged my life in 
multiple ways, it also opened the door to new possi-
bilities and allowed me to fulfill a long-held dream of 
training to be a Certified Guide with ANFT, the Associa-

tion of Nature and Forest Therapy. We’re an international 
organization of more than 1100 guides from 60 countries. 
Our immersive and research-based practice builds on the 
health benefits of Shinrin-Yoku (“Forest Bathing”) while 

HEALING AND ART

also encouraging deeper andmore relational connections 
with the rest of nature, whether in a forest, park, garden, 
or other natural setting.

A Forest Bathing walk is a slow and relaxed way to explore 
the environment, engage all the senses, and experience 
the present moment. It can easily be adjusted for differ-
ent populations, including those with mobility issues. 
We have a saying: “The forest is the therapist; the guide 
opens the doors.” Each walk is a unique experience that is 
guided by a sequence of open-ended sensory Invitations, 
and each participant is free to explore those Invitations in 
their own way. There’s plenty of room for spontaneity and 
creativity. 

In fact, art projects are an important part of the 6-month 
training. Drawing is emphasized as a way to sharpen 
observational skills and become more aware. The ability 
to see subtle details can strengthen our engagement with 
the world around us and also help with recognition of 
specific plants, such as those traditionally used for healing 
as well as potentially hazardous ones like poison ivy. 

Our final assignment was a Harvest Project, a way to 
demonstrate what we “harvested” from the training. 
These projects took many forms, including a children’s 
book, an interactive website, and a long-term plan devel-
oping programs for the Colorado Center for the Blind. My 
project is shown here; it’s called Among the Trees after 
a poem by Mary Oliver. The butterfly in this piece sym-
bolizes the transformative nature of our training, which 
deepened relationships that began in childhood. The 
woods offer a few surprises, as heart shapes are hiding 
among the branches; finding them all may take awhile. 
Among the Trees is currently on display at Vanderbilt Uni-
versity as part of their Art of Healing Exposition, a series 
of in-person and online events that will continue through 
December 2022. 

Please feel free to contact me with any questions, or join 
me for a Forest Bathing and Art workshop in October at 
the Franklin Recreation Center! You can learn more about 
the workshop on my website.

Visit the ANFT website for more information about ANFT 
and the healing benefits of Forest Bathing.

Reshaping the Shadows Looking for Signs
by Elizabeth Sanford

http://www.elizabethsanford.com
https://www.natureandforesttherapy.earth/
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The Healing Power of Art

by Barrie Skoda Foster

Dutch post-impressionist artist Vincent van Gogh stated, 
“Art is to console those who are broken by life”. 

Recently I began 
teaching art 
classes in my 
studio after a 
long hiatus due 
to the pandemic. 
Last week one of 
the art students 
shared with me 
her art journal. 
It was filled with 
art quotes, fun 
and colorful illus-
trations, board-
ing passes, the-
ater tickets, and 
other items. One 
page referenced 
her depression. 

She told me that it was not as bad now that she was able 
to meet up with other artists and paint again. I also feel 
great after creating art, especially if done in a group set-
ting. I always leave art class feeling almost euphoric.

Many of us love creating art. We are often content with 
the act of artin’ itself. Just look at the popularity of adult 
coloring books over the past few years, or the paint by 
number kits my parents used during their leisure time. 
Many of us have an innate desire to paint, dance, sing, 
play a musical instrument, write, act, or in other words 
create art. For me, the need to paint is a driving force that 
calls to me. I find that if I go too long without painting, I 
feel somewhat unbalanced. A small study of 39 partici-
pants at a large university was published in the journal 
Art Therapy in 2016. Participants had the option of using 
collage, model magic clay, fine-tip markers, or any combi-
nation. The authors reported that 75% of the participants 

Above: Barrie Skoda Foster
Right: Close to home
by Barrie Skoda Foster

showed lower levels of the stress hormone cortisol after 
creating art for 45 minutes, regardless of prior art experi-
ence. Tamara A. Sheila published in The Arts and Psycho-
therapy that hospital patients who participated in an art 
therapy session experienced reduced pain and anxiety, 
and improved mood at the end of the session.

Art therapy sessions may include painting, drawing, 
finger painting, doodling, working with clay, carving, 
sculpting, and making collages. Art therapy can address 
the needs of people who experienced trauma, such as 
combat or a natural disaster; individuals with significant 
health challenges, including traumatic brain injuries and 
cancer; and people with certain conditions, such as de-
pression, autism, and dementia. In addition, art therapy 
can help reduce stress and anxiety for people living with 
pain. The practice may also benefit people with eating 
disorders and substance abuse disorders. For people who 
want the health benefits of art therapy without attending 
sessions, there are many options they can do at home. 
These include creating a collage of emotions, drawing 
their mood, blindfold drawing, telling their life story 

through art, practicing mindful drawing, using art as a 
release, and getting together with other artists. American 
poet Nikki Giovanni, said “Art offers sanctuary to every-
one willing to open their hearts as well as their eyes.” I 
agree.

HEALING AND ART

https://www.ncbi.nlm.nih.gov/pmc/articles/PMC5004743/
https://www.sciencedirect.com/science/article/abs/pii/S0197455617301053
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Healing Arts: Connection, 
Understanding, and Shar-
ing Our Stories

by Mallory Montgomery, guest writer

“I haven’t made art since kindergar-
ten.”

Even after six years as an art thera-
pist, I still find myself smiling when 
my new patients in the Detroit 
healing arts art therapy program ex-
press this apprehension. I help these 
patients with their apprehension 
by telling them the truth about art: 
everyone is an artist, even 
those who walked away 
from it for many years. 
After all, humans have 
always made art. Our pre-
historic ancestors captured 
scenes of their daily life on 
stone with the first paints, 
crushed organic material 
that has survived the test 
of time. Art is always waiting for us to 
come back, so that even those of us 
who do not see ourselves as artists or 
creatives may rediscover the magic 
of making. These patients are often 
surprised at how the act of making 
helps heal their anxieties, sadness, 
and fears . Those who choose to 
participate in our patient art show 
are again surprised when they see 
other people connect to their art, 
and these patients are again healed 
by the simple act of sharing their 
creation. And so, the cycle goes: we 
make art to heal ourselves, and then 
we share that healing art with others, 
so they also feel seen, heard, and 
loved. There is something magical 
about art that transcends commu-
nication—it evokes deep emotions, 

moves us to smile or to tears, forges a 
connection to the viewer that says “I 
see you and I hear you.” 

This isn’t simply philosophy; this is 
data driven science. Multiple studies 
have been done on the healing pow-
er of art over the last 60 years, and all 
of them reach the same conclusions: 
art connects the mind and body to 
promote healing . Art making reduc-
es the stress hormone cortisol, helps 
people express themselves, exter-
nalizes negative emotions safely, lifts 
our mood, and improves our self-es-
teem. When we use lines, colors, 
shapes, and symbols to express our 

internal worlds, we share our stories. 
It matters less that the story “looks 
good” and more that we shared a 
small piece of our world to connect 
with others. 

Still, my patients who have not made 
art since childhood need a little coax-
ing, and to be reminded that we were 
all beginners once, seeking to try our 
hand at art. My patients find it is well 
worth working through the worries 
of these early days to begin their 
return to creating art of their own. 
In my practice, I use watercolor art 
across all cancer disease types, with 
multiple mental health concerns, and 
at the end of life. For example, Wa-
tercolor art is known to help anxious 
people relax and helps people with 
obsessive compulsive disorder tol-
erate feeling out of control in a safe 
environment. In a group with combat 

veterans, they were asked to create 
watercolor images and then dialogue 
with the art to achieve catharsis and 
heal their trauma. In hospice care wa-
tercolor painting is used in associa-
tion with the Alzheimer’s Association 
of America to create legacy works 
that the residents give to their family 
members . 

Through the gift of creation, we, 
who were once not artists ourselves, 
reconnect first with ourselves, and 
then others. Our prehistoric ancestors 
left their hands on the walls of caves, 
creating a way for us to connect back 
to them thousands of years later. We 

were all beginners like they 
were once, seeking to try 
our hand at art, to com-
municate and to connect, 
fumbling and learning and 
growing, so that we too 
might be creators. And it is 
in that act of creation that 
we find healing, connec-
tion, and communication 

between all people.

Mallory Montgomery is a board-cer-
tified art therapist who specializes in 
medical art therapy. She works for the 
Henry Ford Cancer Institute in Detroit, 
MI. 

HEALING AND ART
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Importing and Sizing Your Photographs

by Linda Sue Campbell (R5)

Ways to Import Your Photograph

1. USB cable from camera to PC
2. Flash Card directly into PC
3. Flash Card into desktop Card Reader to PC
4. Wi-Fi if Camera and PC are capable

PPI vs DPI

• PPI is the number of Pixels Per Inch in your image
• Affects the print size of your photo
• Affects the quality of the output
• Too few pixels will pixelate the image
• DPI is Dots Per Inch and only refers to the printer
• It is how many dots of ink are laid down per inch
• In relation to a photo, it is a holdover from the days 

when a digital image was printed to a printer using a 
1 to 1 ratio (1 pixel = 1 printer dot)

Working with your photo

• Write down where you store your photo when you 
import it. 
Example: This PC/Windows C:/My Pictures/Photos For 
Judged Show/name of photo

• Open program to work on photo (Photoshop or Pho-
toshop Elements)

• Select the photo with 
which you wish to work 
and crop to remove 
extraneous information

• (Photoshop) Select 
Image/Adjustments 
to adjust the image to 
match your painting

• (Photoshop Elements) 
Select Enhance then 
select appropriate 
options to adjust the 
image to match your 
painting

• (Photoshop) Select 
Image/Image Size to 
bring up the Image 
Size dialog box

• (Photoshop Elements) 

Select Image/Resize/
Image Size to bring up 
the Image Size dialog 
box

• Replace 240 in resolu-
tion to 300.

• The only thing that has 
changed is the Resolu-
tion. If the prospectus 
states that no side can 
be greater than 1800 
px, then you will need 
to adjust the width/
height until you get 
less than 1800 px. I 
substituted 6 for the 
9.646 and the pixels 
came out to 1800. You 
may have to substi-
tute multiple different 
numbers until you get 
1800px or less.

• Ignore the number after Image Size. It is NOT the 
megabytes that you need according to the prospec-
tus. I will show you that number later. This number 
is a calculation made by Adobe that is the uncom-
pressed size of the image. Since you will be saving 
your image as a JPEG, it will be compressed to a 
smaller size.

• By going to Windows Explorer and finding your pho-
tograph in its folder, you can scroll over the picture to 
see how large it is. In this case, it is 1.82 MB.

TIPS AND TECHNIQUES
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In the dialog box, click on “Inches” in 
the Width/Height section and change 
it to “pixels.” 

Then go to The “Resolution” area and 
change the resolution to 300.

Finally, change the longest dimen-
sion to 1800. 

To Size Photographs in Pre-
view on a Macintosh
by Mark Cobbe (R3)

Open your photograph in Preview. 
You can either double-click on the 
photograph file (this should open 
Preview and your photograph), or 
you can open Preview, then go to 
File>Open and search for your pho-
tograph. When you find your photo-
graph, select it and click on open.

Your target size is: 300 pixel resolu-
tion and 1800 pixels for the longest 
dimension and a file size less than 3 
megabytes (MB).

With your photograph open, go to 
“Tools>Adjust Size…”  

You will see the following dialog box: 

For Future Reference: 
Articles to help with 
Exhibitions
Looking back on ArtBeat and Medi-
um! There are several articles written 
over the years that serve to educate 
our membership on various aspects 
of entering an exhibition. Check out 
TnWS.org to find these articles. You 
might want to save this list along 
with a copy of this ArtBeat for future 
reference! 

Fall 2016: Original Artwork: A defini-
tion to keep your work from being 
disqualified in juried competitions. 
by Helen Burton (R3)

Summer 2017: Sound Advice for 
Presentation of Paintings/ Lack of 
Photo Quality: Prime Reason for 
Rejection by Laurin McCracken (R1)

Fall 2017: Tips for Exhibition 2018 
Entry Process by Pat C Patrick (R2)

Fall 2018: Color Correction for Artists 
by Nick Long (R2)

Spring 2020: Use Software that 
Comes on Your Mac to Resize an Im-
age! by Jan Alice Keeling (R2)

Spring 2020: A Great, Cheaper Sub-
stitute for Photoshop by Jan Alice 
Keeling (R2)

Spring 2021: 2022 Exhibition Dos and 
Don’ts by Helen Burton (R3)

Spring 2021: How to Write a Press 
Release by Helen Burton (R3)

TIPS AND TECHNIQUES TIPS AND TECHNIQUES

http://TnWS.org
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Go to “Tools>Show Inspector” You 
will see the following dialog box:

If the document type is NOT .jpeg, 
you will have to export your photo-
graph.

Go to “File>Export…”  

Check the Resulting Size area. It gives 
you an image size in inches and a 
file size. Your image size should be 6 
inches on the long side. 

The file size should be less than 3.0 
MB.  File size will vary according to 
your original photograph.

Click on “OK.”

Save your photograph.

If you are sure that your photograph 
is a “.jpeg”, i.e., shot on your phone or 
iPad, you are done.

Changing File Type

If however, it was shot with a camera 
that does not save the file as a “.jpeg,” 
you will need to check the file type.

You will see the following dialog box:

Change the file type to “JPEG.” Note 
where the file will be saved, and you 
are done!
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Photographing Your Art for the Internet

by Peach McComb 

I belong to a few art groups and organizations made up 
of all manner of artists. Their technological capabilities 
vary, and I am often asked how to photograph artwork 
and how to get it online in the proper size and format. 
I have taken a couple of classes on how to photograph 
artwork effectively and am sharing that information here 
along with some tips on how to get the images online.

Each image should be between 500KB (Kilobytes) to 1MB 
(Megabyte) (1MB) in size, cropped properly, and in focus. 
If you need more information on size and pixels and such, 
please check out the websites below. They are great!

When submitting to a website, or for a competition, 
please make sure that the that the photo resolution is 
high enough. Here are some instructions from the web-
site Shutterstock.com. All geeks use google to find out 
how to do things with software. If all else fails, google it! 
Shutterstock has a free image resizer at this link. (Look 
under TOOLS on the navigation bar.) To use the software 
on your pc, or mac, follow the instructions below.

For Mac

1. Launch Preview: Every Mac with OS X has a version 
of Preview pre-installed on it. The handy program 
allows you to view and edit image files, so it’s perfect 
for resizing a JPEG. First, open the image in Preview 
— either by launching Preview in the Applications 
folder, or control + clicking the image and choosing 
“Open With”.

2. Adjust the Size: Any adjustments to your JPEG can 
be found under the Tools section of the menu bar. 
Choose “Adjust Size” to open a new dialog box called 
Image Dimensions. This allows you to change the 
width/height, resolution, and other measurements. 
For the average user, we recommend changing the 
measurement to “percent” and then choosing a num-
ber that fits within your target size. When you change 
this value, the “Resulting Size” section will tell you 
exactly how big your new file will be.

3. Save a New Version: After clicking “OK”, you’ll be able 
to see how the image looks with its new sizing. Fear 
not — you can undo the changes if it doesn’t look 
right. Just click Command + Z to undo. However, if 
you’re pleased with the results, select File and then 
“Save As” to create a new version of your JPEG. Give 
it a new name, like “[Image] Small” or “[Image] Web 
Version” and click “Save”.

On a Mac in Preview, open the image and click on Tools 
and then Adjust Size:

Unclick Scale Proportionally and Resample Change the 
resolution from 72dpi to whatever you want, 300 to 500, 
are a good size. Please note that you can see what the 
size of the image below under Resulting Size Click OK and 
you are done.

For Windows

1. Launch MS Paint: Every Windows user has toyed 
around with Paint, a fun program that you can use for 
amateur cartooning and abstract artwork. However, 
not everyone knows that Paint can also resize images 
and tweak their resolution. It’s so easy to do! First, find 
the Paint program by clicking Start, “All Programs”, 
and then “Accessories”. It doesn’t matter if your com-
puter has Windows 95 or Windows 10 — there will 
be a version of Paint preloaded on your operating 
system.

2. Find the Resize Option: To resize an image, select the 
“Home” tab and look for the “Image” heading. There 
will be a “Resize” option. When you click on it, a new 
dialog box will appear with more advanced settings. 
Before adjusting the size or pixel count, it’s important 
to check the “Maintain Aspect Ratio” box to keep the 
image’s dimensions intact. 

3. Tweak the Resolution: Besides adjusting the picture’s 
size by a specific percentage, you can also change the 

TIPS AND TECHNIQUES
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resolution. Just click “Pixels” and decide how many 
pixels per inch you’d like for the smaller JPEG. 

4. Save a New Version: If you’re happy with your new 
size settings, select “Save As” from the main menu. 
We recommend saving a new version of the image, in 
case you need to use the original file at some point. 

From Shutterstock.com, an excellent website for informa-
tion.

Informative Websites

Check this link for more information on pixels. 

MB is megabytes and that means how large the file itself 
is. For example, 1MG (megabyte) would be 1,000KB (kilo-
bytes). This link explains it more clearly. 

Check out this blog from Will Kemp Art on how to avoid 
mistakes when you are photographing your art with a 
smart phone. It’s GREAT! artworkarchive.com is a very 
informative website with lots of info about art business: 

Tips and Tricks

If shooting indoors, get next to a door or window. Use a 
see-through white shade for diffused light. You may also 
use a sheet. Anything that will diffuse the light coming in 
the window to eliminate glare, especially if the painting 
has already been varnished. Speaking of that, you may 
want to photograph your work (oil/acrylic) while it’s still 
wet. Photograph watercolor after it’s dry before framing 
it.

You can photograph your artwork outside, too, out of 
direct sunlight. In sunlight the colors photograph much 
differently than they do in shade.

1. Use a blank white wall for a background if possible. 
This cuts down on postproduction time by helping 
balance the color. If you do not have a blank white 
wall, put mat board, or white foam core, on an easel 
and put the art in front of it.

2. Get directly over the art, square it up in the view find-
er and snap the photo.

3. Use your phone, if you do not have a camera and 
tripod. The new ones have great cameras! Don't 
use flash. Turn off the digital zoom, auto-focus and 
auto-exposure, if they are settings on your camera, or 
smart phone, and do not use a wide-angle lens.

4. Photograph art BEFORE framing and varnishing. If the 
framed piece is under glass, you will need to pull it 
out as it’s hard to photograph through glass without 
a glare.

5. If you use a gloss varnish, photograph your work 
before adding the final coat of gloss 

6. Take several photos and then take a few more. You 
can compare them later.

7. The camera lens needs to be parallel and centered to 
the painting. This is probably the most important and 
trickiest part.

8. Square your phone, or camera, up to the art, by mak-
ing sure the art looks straight up and down and even 
on the bottom through the lens.

9. Once you have taken the photo, adjust it on the 
phone, or your iPad, tablet, or computer, using your 
photo editing software.

There are several, easy to use, image editing applications 
out there. The WIX Photography blog has information 
about this editing software that you can use to adjust 
your artwork 

You can send your photo to Instagram, Facebook, your 
email, and your website, right from your phone, or tablet, 
once you have cropped the photo and gotten it the way 
you want. You can also put/download your photo on to 
your computer. Check out the file name, the size, and 
kind indicated in each column. Those sizes may be too 
big to send for a website, so please compress the files to 
1 to 2 MBs if you know how to do that. If not, check out 
your photo editing software to adjust the image size to a 
smaller one.

The other issue is when you send photos that are SO 
small 75KB(kilobytes), for example, that they are blurry 
when loaded to a website, or online to FaceBook, etc.

If you want to put a photo on FaceBook, or Instagram, 
right from your phone, you must first open the applica-
tion on your phone and sign in. Next, select the photo, 
click the upload icon, and it should show options below 
the photo such as FaceBook, Messenger, etc. Pick the one 
you opened, and you are on your way. You may also share 
your photo to Facebook from Instagram.

©Peach McComb Art with Attitude 2020 

 

http://Shutterstock.com
https://www.computerhope.com/jargon/p/pixel.htm
https://www.reference.com/world-view/difference-between-megabytes-gigabytes12fa25a621e66141
https://willkempartschool.com/how-to-photograph-your-paintings-with-your-iphone/
http://artworkarchive.com
https://www.artworkarchive.com/blog/4-steps-to-photographing-your-art-like-aprofessional
http://wix.com/blog/photography
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Why Journals? Finding Your Own Way

by Tuva Stephens

The purpose of this brief article is to share my personal way 
to my watercolors. The simple truth is I could NOT paint well 
without writing about my art. There is a spiritual connection 
between the hand, heart, mind and soul. I had three decades 
to think about being a “real artist” while teaching visual art, 
English and drama to high school students.

Writing about 
my paintings 
has given me a 
deeper meaning 
in understand-
ing myself and 
my art. I do my 
problem-solv-
ing by writing 
thoughts in my 
journals for each 
serious painting; 
“planning leads 
to the intuition 
to just paint!” All 
I need is written 
in two sizes of 
journals.  Small 
hardback (4 x 6) 
journals are kept 
on a shelf within 
easy reach. The 
other (8 ½ by 11) 
journals contain 
stories, sketch-
es, goals, dates, 
workshop notes, 

and words of encouragements from others. 
Keeping a list of accomplishments/awards is 
also invigorating to read, review and reflect. 

In my opinion the guide to a successful 
painting is having a PLAN. I jot down the an-
swers to these questions before there is a single 
brushstroke made. While drawing the subject, 
I write a few adjectives in the margins of the 
edge of the paper for example “humble but 
strong” for a portrait. Concentrate on what you 
want to say about the subject. Keep it simple.

What is the intention or purpose of the paint-
ing? (I usually write a few sentences about ex-
pressing the “essence” of the person if painting 
a portrait.) Light is always an important when 
painting any subject. Decide the kind of sur-

TIPS AND TECHNIQUES

face (rough, soft, cold-press, hot-press/300 lb or 140 lb) 
that would be best for that particular painting. Consider 
all your options in techniques in order, for example, wet-
on-wet, wet-on-damp, dry brushing, scratching, atomizer, 
lifting, stencils, etc. As I am listing these techniques, I am 
thinking of the steps that will be followed in my flexible 
intuitive approach with expressive marks. This is a type of 
visualization of a finished painting. Let the painting tell 
you what to do next!

What elements and principles will be used to create a 
strong composition? (This is also important to note the 
style of the painting.) Usually I use the same ones and that 
gives me my style. Example: variety of texture and value; har-
mony and emphasis of color; movement of form, repetition 
of form, etc. (A design chart is helpful.)

What colors will be used in the painting? Name them. Be 
specific. (A limited palette of selected colors will create 
Unity.)

The stories I have found in my notebooks have driven my 
paintings to completion. I usually end my paintings with a 
tear, a sigh or a smile. Writing has helped me to enjoy my 
journey as an artist.  For example Nita Leland said, “Build 
on Your Strengths. Avoid Negative Influence. Trust your 
instincts. Resist impulses to correct small mistakes. Learn 
to handle criticism regardless of the source.”  And above 
all else BELIEVE IN YOURSELF! Writing in my journals has 
made the experience of art much richer. 

National and international painter award winning, Tuva 
Page Stephens is a signature member of National Water-
color Society, Transparent Watercolor Society of America, 
Watercolor West, Watercolor Society of Alabama (Gold), 
Kentucky Watercolor Society of America, Missouri Water-
color Society, Southern Watercolor Society and Tennessee 
Watercolor Society. See Tuva’s website online.

http://tuvastephens.com
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Painting Records

by Pat C. Patrick

Have you ever wanted to enter a painting into a show, 
but can’t remember if it has already been accepted there 
before or what paper was used? One way to be ready for 
exhibitions is to take a high quality photograph of the 
finished painting, but how do you keep that so that you 
can find it and the other needed information?

I use a Mac and keep A LOT of reference photos sorted 
into albums on the computer.  But once I paint from that 
photograph, 
I save it on a 
portable hard 
drive (or thumb 
drive) along with 
any photos I take 
as the painting 
progresses. I 
usually use my 
iPhone for these. 
Once I think I am 
finished, I use a 
Sony Alpha with 
24.3 Mega Pixels to take a high quality photo that is saved 
as both an ARM and a JPEG. I shoot in light shade or an 
overcast day using a camera on a tripod.

I may take several photographs, but save the best on the 
thumb drive in the folder with the reference. I save the 
originals without any cropping or adjustments. I then 
crop the photograph to remove anything that would be 
covered by the mat. I rename the photograph file to the 
same folder. I then open in Preview/tools and adjust the 
resolution and dimensions as required by the exhibition 
prospectus. I then save this file named as required. I may 

have several files 
in this folder with 
different resolu-
tions and names. 

I also print a very 
small print of 
each painting on 
just regular pa-
per and tape into 
a bound note-
book or journal. 
Information such 

as matted dimensions, framed dimensions, type paper, 
brand of paints, use of plexiglass and maybe location of 
reference is recorded. Good information might also be 
cost of framing and materials. Also entered is each time 
the work is submitted to an exhibitions and note if it was 
accepted. Cost of entering and any prize money or sale 
can also be recorded.

A Tool for Projecting Images

by Mark Cobbe

Those of us who have been painting for a while probably 
have used various methods to get your image onto the 
paper. There is direct drawing, which can intimidate one 
if the image is complex; think a city street scene. There 
is the projector, which most of us had in the old days to 
project slides onto the paper. But with us all moving to 

digital, buying a 
good digital pro-
jector can cost 
between a $200 
and $600. 

There is a low-
tech way:the 
Camera Lucida.

The Camera 
Lucida uses a half 

silvered mirror to allow the artist to see both the subject 
and the paper at the same time. The problem with a cam-
era Lucia is that it can only be effectively used in a studio 
setting.

Recently, the Artist’s Network sent an email about an 
application that works on both iOS (iPhone and iPad) and 
Android: Da Vinci 
Eye AR. This app 
takes one of your 
digital photos 
and superimpos-
es it of the image 
of your paper. 
And the best 
part—it costs 
$4.99! The Da 
Vinci website has 
many very good 
videos showing 
how to use it. 

TIPS AND TECHNIQUESTIPS AND TECHNIQUES

https://www.davincieyeapp.com
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Sargent's Women, Four Lives Behind the Canvas

by Donna M. Lucey

Donna Lucey explores the 
lives of four women paint-
ed by John Singer Sargent 
using original letters and 
diaries. Read about Elsie 
Palmer (Portrait of Elsie 
Palmer), Sally Fairchild 
(Lady with a Blue Veil), 
Elizabeth Chanler (Eliza-
beth Chanler), and Isabella 
Stewart Gardner (Isabella 
Stewart Gardner). Learn 
about the women and how 
their lives intertwined with 
Sargent.

John Singer Sargent Watercolors

John Singer Sargent Watercolors is the catalog from the 
joint Boston Museum of Fine Arts and the Brooklyn Mu-

seum exhibition. 
These two muse-
ums purchased 
theses paintings 
from the only 
two shows Sar-
gent held in the 
United States.

Although best 
known for his 
portraiture in 
oils, Sargent was 
also a prolific wa-

tercolorist, painting mostly plein aire. He actually started 
painting in watercolors in 1868—1869, between  the ages 
of twelve and thirteen.

This catalog discusses his various influences and puts his 
paintings is historical perspective. It also examines his 
watercolors, not by date, but by subject, allows the reader 
to see how he approached each subject over a period of 
time.

Sargent’s approach to watercolor painting disregarded 
the norms of the day. Instead of carefully delineated and 
composed landscapes, he painted in bold, dense strokes, 
loosely defined forms, and unexpected vantage points.

There is also an 
in-depth article on 
Sargent’s materials 
and techniques. 
As he primarily 
painted plein 
aire, his paintings 
were generally 16 
x 21” or smaller, 
because he used 
watercolor paper 
blocks. He also usually painted on rough paper. 

His techniques included applying china white to add 
highlights, although he generally retained the white of 
the paper. His other techniques include scraping and 
modifying the working properties, for example adding ox 
gall to improve the flow of the pigment.

This book contains over 100 of Sargent’s watercolors.

Painter's Guide to Color 
by Stephen Quiller is a 
wonderful book recom-
mended by Kate Aubrey 
during a recent program 
for TnWS.  The book was 
written for artists and is full 
of wonderful color theory 
techniques. Excellent for 
training ones   eye to see 
and use color in new ways.

The Artist's Way by Julia 
Cameron is a book many 
of us have in our libraries. 
This is another of the books 
Kate Aubrey recommend-
ed in her presentation. If 
you haven't read it, then 
do. And do your morning 
pages while you are at it!

Above: White Ships
by John Singer Sargent

BOOKS OF INTEREST


